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36 FILLABLE FORM TEMPLATES  

WHAT ARE FILLABLE FORM TEMPLATES?  

A fillable form is simply a template which utilizes Word form fields. In Word 2003, you created these forms by using 
the tools on the Forms Toolbar which looked like this: 

 
FIGURE 36-1 

Users would be able to create a new document based upon a template using form fields and simply hit the Tab key 
to move from field to field. It was easy and slick. Microsoft changed this after Word 2007. You can still get to the 
old form fields, but they are well hidden (as explained below). They've clearly intended to replace those form fields 
with a new thing Content Controls. Content Controls are nice and offer a few new things that the old form fields 
did not. However, there are many aspects of them we do not like. Tasks which were fairly simple and straight-
forward with the legacy tools are complex to replicate with Content Controls. As a result, we recommend you use 
the old types of fields called the Legacy Form tools.   

SIGNIFICANT BENEFITS OF FILLABLE FORMS  

Fillable forms allow you to answer only a few questions and get a complete or nearly complete document. For 
example, you can ensure that all pronouns are correct by choosing only one. In other words, I can set up a field 
where the user chooses between him and her. As soon as that single response is received, every pronoun in the 
entire document is completed accurately (he/she, him/her & his/her). Simple logical changes can be made 
throughout a document based upon how a question is answered as well. For example, you can create a drop-
down/multiple choice field for Defendant or Defendants (depending upon whether there is more than one 
Defendant). After the user chooses an option, the form can automatically enter the correct verb conjugation. For 
example, "The Defendant is represented by counsel." or "The Defendants are represented by counsel." 

CREATE A FORM  

In order to create a Word form, complete the following steps:  

1. Create a template. It is probably easiest to pull up an existing document you created for a client which is 
a good representation of the variety you use most often. To create a template from an existing document, 
open the document and click Save As…, in the Open dialog, change the Save as type box to "Word Macro-
Enabled Template (*.dotm)." 

2. Show Fields. It's really hard to create fields without being able see them and you won't be able to see 
everything unless you toggle field codes on in Word. The speed key for this is Alt+F9 in all version of Word. 
Turn it on while you're creating your template and make sure you turn it off (just hit Alt+F9 again) after 
you save it or everything will look completely messed up when you try to use your template. 



 CHAPTER 36 
 

MICROSOFT WORD FOR LEGAL PROFESSIONALS  Page 272 

3. Enable the Developer Tab/Ribbon. If you don't see the Developer tab, click the File Menu  Options 
button (left side)  Customize Ribbon (left side)  check the box adjacent to Developer (right side). 

 
FIGURE 36-2 

4. Insert fields. The fields you want to use are in the Controls Group of the Developer Ribbon. You do not 
want to use the Content Control buttons for the reason outlined above. You want to use the Legacy Tools 
button: 
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In Word 2010, it looks like this: 

 
FIGURE 36-3 

In Word 2013/16/19, it looks like this: 

 
FIGURE 36-4 

In Word 365, it looks like this: 

 
FIGURE 36-5 
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5. Set field properties. After inserting a form field, double-click it to set or edit properties for each field. You 
can also add Help or automation to a form in the field properties. 

6. Protect the form. Prepare the form for distribution and collection of information by protecting it. To do 
this, click the Restrict Editing button.  

 
FIGURE 36-6 

A pane will appear on the right side of the screen. Check to enable Editing Restrictions, and choose Filling in 
forms from the drop down list below. Click the Yes, Start Enforcing Protection button and it's probably a good 
idea to give it a password. 

 
FIGURE 36-7 

7. Distribute the form. 

FORM FIELD DESCRIPTIONS AND USES  

I realize that there six buttons on the Legacy Forms mini toolbar. You're only going to use the left-most three (which 
are described below).  

If you insert a field but you can't see it, then you need to click the Form Field Shading button - . 

Text Form Fields  

 - This field can be used for text, number, date, the current date, the current time or a calculation. As you can 
see from the Properties dialog below, you have many controls for text form fields. It is very important that you not 
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leave the bookmarks as their defaults (like Text1). You can't have spaces in the bookmark names, but you can use 
underscores. 

 
FIGURE 36-8 
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Check Box Form Field  

 - This field is used to create a box which can be checked or unchecked. Beyond changing the name of the 
bookmark, you can change the default value from not checked to checked if the box should be checked by default. 

 
FIGURE 36-9 
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Drop Down Form Field  

 - This field allows you to create a multiple-choice for the user. To add options to the drop down, enter them 
under the Drop-down line. Then click the Add button. 

 
FIGURE 36-10 

ADVANCED TECHNIQUES  

Repeat the Result of One Field in Other Places in the Document  

There are many times in which you want the same answer supplied in one field to appear in multiple other fields 
in the document. For example, when a client's name appears multiple times in a form, you only want to have to 
enter that name once. When you drop a text field into a template, Word automatically inserts a corresponding 
bookmark. You can use that bookmark to drop the result of that field elsewhere in the document. Just follow these 
steps: 
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1. Insert a text field into your template. After you've inserted the field, double click the field to view its 
properties in the Text Form Field Options dialog. Note the name of the bookmark (in this example below, 
Client_Name) and check the Calculate on exit box. 

 
FIGURE 36-11 

2. Now place your cursor somewhere else in the form where you would like to repeat the answer to this 
field.  
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3. On the Insert ribbon, click the Quick Parts button  Field  In the Field names list, click Ref. Select the 
appropriate bookmark, then click OK. 

 
FIGURE 36-12 

4. Don't forget to protect the form. Save the form template, close it and generate a new document from your 
template to test. 

Making Fields Contingent Upon Another Answer  

Let's say your form has a drop-down field which presents the user with the option of Defendant or Defendants. A 
sentence in the document says "The Defendant in this matter has been served with process." Of course, if there 
is more than one Defendant, the subject and verb of the sentence would change to this: "The Defendants in this 
matter have been served with process." 
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FIGURE 36-13 

Of course, you can easily create a drop-down field for the Defendant/Defendants option. In the perfect world, that 
choice would automatically change the verb conjugation from has to have as appropriate. Well, you can set up 
your form to do that kind of thing. It's not exactly a user-friendly setup, but it works very well. Here are the steps: 

1. Setup a Drop-Down form field to replace the word Defendant. Add the two options, change the Bookmark 
name to "Defendant," and don't forget to check "calculate on exit" as this is necessary for it to work. 

2. Now delete the word "has" from the sentence. Position your cursor between the words "matter" and 
"been" and hit Ctrl+F9. A field will appear with brackets in them like this { }.  

3. Put your cursor between the brackets and type IF.  

4. Hit Ctrl+F9 again to insert another set of brackets (these being nested). Now it looks like this: { IF { } } 

5. Position your cursor between the nested brackets and type "Defendant" (the name of the bookmark you 
assigned to the drop down field). 

6. Now move your cursor outside the nested brackets and type: = "Defendants" "have" "has". The whole 
thing should look like this: { IF { Defendant } = "Defendants" "have" "has" }. 

The IF field is evaluating whether the Defendant bookmark is equal to "Defendants." If it is, it will output 
the first option, in this case "have." If it is not equal to "Defendants," it will output the second option 
("has"). 

7. Protect the form, save it, close it and try generating a new document based upon your template. If you did 
it correctly, the have/has will change automatically depending upon what you choose for 
Defendant/Defendants. Don't forget that you have to hit a TAB key in order for it to take effect. 

Automatically Unlock the Form  

When the user exits the last field in the form, you can write a macro which automatically unprotects the form so 
that the user can type wherever they want. It's rather complicated, but here are the steps: 

1. Edit your form.  
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2. Click the View ribbonMacros buttonRecord macro... 

3. In the next dialog, call the macro UnlockForm and make sure you Store macro in the template you're 
editing. 

 
FIGURE 36-14 

4. As soon as the macro has begun recording, stop recording by clicking the  button on the status bar at 
the bottom of the screen. 

5. Now edit the macro by clicking View ribbonMacros buttonView Macrosfind the macro you 
recorded and click Edit. Between the Sub and End Sub lines, add this: 

ActiveDocument.Fields.Unlink 

ActiveDocument.Unprotect 

Selection.HomeKey Unit:=wdStory 

6. Now click File menuClose and return to Microsoft Word. 

7. Now locate the last field the user enters information into in your form and double click the field to open 
the properties. 

8. Under "Run Macro On" click the drop down under Exit and choose the macro you created. 

9. Protect the form. 

10. Save the form. 

FILL A FORM  

In order to fill a form based on a form template, click the Office ButtonNewclick My Templateschoose the 
template/form. In a protected form, you can advance from field to field by hitting the Tab key. 

USING FILL- IN FIELDS  

This is not as sophisticated as the foregoing, but Fill-In fields are a very easy way of entering information into blanks 
in a form. Just follow these steps: 
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1. Create a template. It is probably easiest to pull up an existing document you created for a client which is 
a good representation of the variety of work you use most often. To create a template from an existing 
document, open the document and click Save As…, in the Open dialog, change the Save as type box to 
"Word Macro-Enabled Template (*.dotm)." 

2. Show Fields. If you don't do this, you will not be able to see the fields you're entering. Just hit Alt+F9 to 
toggle the field codes on. After you're done inserting all of your fields, hit Alt+F9 again to turn the fields 
off. 

3. Place your cursor where you would like the user to enter information, then click the Insert ribbon  
QuickParts  Field  Fill-In. Type in a prompt you want the user to see. 

 
FIGURE 36-15 

4. Repeat the foregoing step until you have fields inserted everywhere you want them. 

5. Save the template again and close it. 

6. Fill in the form as described in the previous section (double-click it). You'll see that the prompts pop up 
and ask you for each input. 

Re-Using User Responses Elsewhere In The Document  

For example, if you use a Fill-In field to gather the client's name at the top of the document, it would be handy if 
you could re-use it elsewhere so that the field only has to be answered once.  This is a little tricky, but not difficult 
once you know the steps. 

1. Open the template you added Fill-In fields to. 
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2. As described above, hit Alt+F9 so you can see the fields in your document.  Below, I'm showing you a field 
that asks for the client's full name (as you can tell by the prompt in quotes). 

 
FIGURE 36-16 

3. Now select the field as you would any text (hold down left mouse button and drag, etc.). 

4. Once the field is selected, click the Insert ribbon  Bookmark button  give the bookmark a meaningful 
name (such as Client_Full_Name, in this case - but you cannot use spaces in your name)  click the Add 
button.  You have now "wrapped" your field with a bookmark although you won't be able to see the 
borders of the bookmark. 

5. Go to the first new location where you need the response to show up from the Fill-In field, and select 
whatever text you want to replace with the client's name automatically. 

 
FIGURE 36-17 

6. Click the Insert ribbon  Cross-reference button  switch Reference type to Bookmark. 

 
FIGURE 36-18 

7. Click on the bookmark name you made for field result you want to repeat  make sure Insert reference 
to: is set to Bookmark text  click the Insert button.  Do the same thing everywhere else in the document 
you want to repeat the result of that field. 

8. Hit Alt+F9 to turn off the field codes, save the template and close it.  Then run it as described above 
(double-click it).  You'll see that after you answer the Fill-In field prompt, it will automatically insert the 
same text everywhere else you added the cross-reference fields. 


